
Anamorph Me!

User’s Guide (Version 0.2)

by Phillip Kent

www.anamorphosis.com



2

This document and the software it describes are Copyright © Phillip Kent 2001.

The program is based on the following copyrighted code:

• Paintlib C++ class library, Copyright © Ulrich von Zadow, 1996-2000

• “Piclook” sample application for Paintlib, Copyright © Bernard Delmee, 1998

For information and downloads for Paintlib, see http://www.paintlib.de

Anamorph Me! is made freely available for non-commercial purposes only. It is provided “as
is” and is not warranted to be suitable for any particular purpose.

For commercial use, please contact me via email to p.kent@mail.com .

FEEDBACK

Any comments on the software are extremely welcome, via email to p.kent@mail.com .

For occasional news about the software and web site, you can join the mailing list via the
“Listbot” input box at www.anamorphosis.com .
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Introduction
Anamorphosis: A distorted or monstrous projection or representation of an image on a
plane or curved surface, which, when viewed from a certain point, or as reflected from a
curved mirror or through a polyhedron, appears regular and in proportion.
(Webster’s Dictionary)

Traditionally, anamorphoses have been created using grid templates. One starts by making the
anamorphic transformation of an empty square grid, according to certain choices about the
position of the viewpoint, the sizes and angles of the mirrors, etc. Then, the square grid is put
on top of the original picture, and the contents of each small grid element are copied across to
the corresponding element of the distorted grid. This illustration shows two sets of grids
prepared by Jean-Francois Niceron in 1646:

Making an oblique perspective anamorphosis: the parts of the original image (above) are
copied square-by-square into the distorted grid. Once this is done, the grid must be removed

to leave the anamorphosis.

Making a cylindrical mirror anamorphosis.
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Needless to say, using grids is a time-consuming business, and requires a fair amount of
artistic skill. With computers, anamorphoses are much easier to make because the rules
(algorithms) for anamorphic distortions can be written as computer programs, which can then
be applied directly to the many thousands of individual pixels of a digital image. (For the
computer, any image is literally a grid of coloured squares, known as “picture elements”,
pixels for short.)

Anamorph Me! allows you to carry out almost all the traditional anamorphic transformations
that use perspective and mirrors. Though, at the moment, not all the transformations are
implemented, and some of those that are implemented are not as good as they should be.
These deficiencies will be dealt with in future versions of the program.

If you have used image manipulation software before, you should find Anamorph Me!
straightforward to use. Do “Open…” in the file menu to load in any JPG, BMP, TIFF, etc.
image (but not GIF), click on the “Anamorph” menu and start experimenting. One thing to
watch out for is that the transformed images are always made larger than the original—there is
no automatic scaling down—so the output images can get very large. Note that under the
“Image” menu you can Resize images before anamorphing them.

If you are looking for art images (such as Leonardo’s Mona Lisa) to work on, visit web sites
such as The Artchive (www.artchive.com) and the Web Gallery of Art
(http://gallery.euroweb.hu ).

For a detailed introduction to anamorphosis itself, see my web site at
www.anamorphosis.com.

Downloading and installing
Anamorph Me! is a program for Microsoft Windows operating systems. It should run in any
of Windows 95, 98, ME, NT, 2000 (but see Known Problem 2 below for Windows 95).

You can download the program from
   http://www.anamorphosis.com/software.html
More specifically:
   http://www.anamorphosis.com/anamorphme02.zip
   [file size 252 Kbytes, and you'll need an unzip program]

When unzipped, you should have a single program file “AnamorphMe.exe” (760 KB). To run
it, just double-click on the file (in the normal Windows fashion).

There is no installation (or uninstallation) procedure for this version of the program. Simply
put the AnamorphMe.exe file in any convenient location — you can make a shortcut to it, or
include it in the “Start” menu in the usual ways.

Known problems and Forthcoming features
1. This is a prototype version, and it will break under some circumstances. Make sure to

save immediately any anamorphosed images that you want to keep. You can save images
by doing “Save As...” from the File menu. Unfortunately, the “Save changes” dialog box
that appears when you close down a window DOES NOT work for saving.

2. This program needs a Microsoft library file called “MFC42.DLL” to be installed on your
computer. If you are using Windows 95, it’s likely that you’ll get an error message saying
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that this file cannot be found. You can get a free library update from the Microsoft web
site.

3. Printing may be erratic, especially when using a USB connection. I’ve seen two kinds of
problems: (1) the print job hangs in the print queue—rebooting the computer should fix
this; (2) the printer output is blank—this is a more persistent problem, which I don’t know
how to fix. But you can print JPG files using, for example, the Paint program which is
included with Windows.

4. The “Zoom” mode (magnifying glass icon in the tool bar) DOES work for zooming out —
if you press the Ctrl key whilst you click the mouse inside the image, the image will resize
to fit within the window.

You’ll notice that several items in the program menus are greyed out. These will be
implemented in the next version:

• a TWAIN interface for digital cameras and scanners;

• a “Copy” option so that you can paste images directly into the program from the Windows
clipboard;

• an Anamorph option implementing the exact transformation for a cylindrical mirror;

• an Anamorph option for pyramidal mirrors.

Overview of the program
The “File” menu gives controls over opening, closing, saving and printing of files. You can
have any number of image files open (computer memory permitting) at one time. As usual
with Windows, the image whose window is “selected” (that is, on top of all the others) will be
subject of any operation chosen from the menus.

The “Image” menu contains a few basic manipulations: resizing, rotation (in units of degrees,
anticlockwise; use a negative number to rotate clockwise), cropping (ie. selecting out a
rectangular part of the image), conversion to black-and-white (greyscale), and negative (which
outputs an image which is like the photographic negative of the original).

           

The Image commands are limited, and are not intended to be as good as a dedicated piece of
imaging software. If you don’t have this kind of software, you can get some very good
packages for free — on the web site you’ll find web addresses for Irfanview and The GIMP.

The “Anamorph” menu provides access to the various anamorphic transformations. Each
transformation is discussed in detail in the following sections.
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Oblique anamorphosis
Viewing an image obliquely (that is, from an angle that is not 90 degrees) was the first kind of
anamorphosis to be developed, at the end of the 15th century. The earliest known examples are
contained in the manuscripts of Leonardo da Vinci. To find out more on the history, see the
anamorphosis web site (www.anamorphosis.com/exhibition) . The “Oblique” dialog box
contains four inputs:

“View from” controls the direction from which you want to view the anamorphosis:

         
Right                                                                 Left

Top                                         Bottom

                              

The other three inputs control the viewing position for the anamorphosis: the best option to
change here is the viewing distance (which is measured relative to the actual dimensions of
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the original image). The greater this distance, the more stretched out the anamorphosis will
look, and you will need to look from further away to see the undistorted image.

(To be honest, the current version of the Oblique transformation is not that well-designed, and
it will be changed significantly in the next version of the program.)

It is easy to think that oblique anamorphosis is to do with stretching an image, but it is more
than that, as you will see if you compare the “Oblique” transformation with the “Linear
stretch” transformation:

Projections on to cones and pyramids
As explained in the exhibition panels (www.anamorphosis.com/exhibition) anamorphoses do
not have to be flat images. They can be made on any shape, but it is easiest to do the
calculations for a regular shape such as a cone or a pyramid.

The “Inside/outside a cone” transformation projects a flat original image onto the inside or
outside surface of a cone. Then, to view the anamorphosis you need to look into the cone, or
look directly at the tip of the cone, from a specific distance (called the viewing distance in the
dialog box). You can control the cone angle (which is actually half the angle at the top of the
cone): the smaller this number the “more pointed” the cone will be.

You also need to decide whether you want to use the whole original image, or “clip” the
image to use just a central circular portion of it. It’s not essential to modify the “cone radius”
input, but generally this should be set to about half the smallest dimension of your original
image (that way, you’ll make most use of the image resolution available).
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The program cannot easily show you a 3-dimensional cone on a 2-dimensional computer
screen, so what it does is to give you a “rolled out”, flattened cone. If you print this image,
you can roll it up to get the proper cone shape.

For example, let’s start with a detail from Dürer’s Self-portrait at age 28, and transform the
whole image to the inside of a cone (angle = 22.5, viewing distance = 2):

  

Then, print out the rolled-out cone and cut around the edges leaving a gluing flap on one of
the straight edges:

Attach some (preferably) double-sided tape to the gluing flap, join the straight edges together
and there is the cone:
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Projections onto pyramids work similarly to cones.

“Pyramid angle” refers to the angle at the top of each of the triangular faces that form the
pyramid. So, the smaller this angle, the more pointed the pyramid will be. “Base length”
refers to the side length of the square at the base of the pyramid; you don’t need to modify this
number, but it should be roughly equal to the smallest dimension of the original image.

When you come to print out and assemble your pyramid, you need to make a gluing flap as
for the cone, and also you need to do make folds along the edges of the pyramid:

The pyramid as printed flattened out from the program
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Cut out, and folded along the edges

Join the edges, and stick with tape, to form the pyramid.

Cylindrical mirror anamorphosis
The mathematics for this transformation can be done exactly or approximately. The current
version of the program only implements the approximate version, which makes use of “polar
coordinates” (the x coordinate of the original image becomes the angle coordinate, and the y
coordinate becomes the radius coordinate). The grids for this transformation are shown in the
second of Niceron’s illustrations on page 3.
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The input dialog has just two inputs: the “mirror radius”—or more exactly the radius of the
centre “hole” in the anamorphosis, and the angular size of the anamorphosis. The funny thing
is that you can get reasonable results for many different choices of these options. Typically,
you’ll want the angular size pretty large (200-250 degrees) since this produces an
anamorphosis with a good amount of distortion, and the mirror radius set at about one-third of
the height in pixels of your original image.

     
Original image (400 x 600 pixels)         Anamorphosis with radius = 200, angular size = 220

How to construct a cylindrical mirror
The current version of the program does only approximate cylindrical anamorphoses, and for
these you do not need to be very precise with the mirror, since you won’t get a perfect image
in the mirror anyway.

Reflective, mirror plastic is produced under the trade name “Mylar” (among others). It can be
bought in thin sheets from stationery and craft shops. Thicker versions (which work better) are
used for window insulation (eg. in greenhouses) and you may find this in gardening supply
stores. It is also used in some forms of commercial printing, and I myself have picked up lots
of it very cheaply at a “recycling arts project” in north London, which gets “unusable” rolls of
the material donated to it by a local printing company. Besides plastic, it is possible to make
stainless steel cylinders which are polished to high reflectiveness, but I have not personally
tried this. You can make the mirrors more stable by wrapping the plastic around a cardboard
tube (for example from a roll of kitchen towel).

For an anamorphosis printed on A4 paper you’ll need a cylinder about 12cm high. To make
this out of plastic, cut out a rectangle that’s 12cm high and whose width is determined by the
diameter of the mirror that you want. (Note that on some types of this plastic, one side is more
reflective than the other, so make all marks on the duller side.) For example, if the diameter is
5cm, the length of the rectangle should be • (=3.14 approximately) times 5, that is 15.7cm
PLUS about 0.5cm extra to make a gluing strip.

In fact, the diameter you choose is not very crucial. It should be a bit less then the diameter of
the centre “hole” at the middle of the printed anamorphosis. If you move the mirror cylinder
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around a bit, and change the height and distance from which you are viewing it, you should be
able to find a reasonable reflected image.

Measure the diameter of the centre “hole”—it’s about 5cm …

…so we’ll use a mirror diameter of 4.5cm, for which we need a rectangle 12cm high and
14.1cm wide PLUS 0.5cm for a gluing strip, which is covered with double-sided tape. The two

edges highlighted in red must be made to meet, with the gluing strip on the outside.

To see the reflected and (approximately) undistorted image, experiment with the mirror
position and also the height and distance from which you are looking.
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Conical mirror anamorphosis
This transformation produces anamorphoses which look especially distorted, because the
conical mirror has the effect of “inverting” the image: the centre of the original becomes the
outside of the anamorphosis, and vice versa (see Panel 10 of the exhibition, at
www.anamorphosis.com/exhibition) . On the negative side, these anamorphoses need a very
precise mirror to work well, and this is not easy to make out of plastic.

The input dialog gives you five choices: (1) the cone angle (which is actually half the angle at
the top of the cone; the smaller this number the “more pointed” the cone will be); (2) the cone
radius, which you don’t have to modify, but generally this should be set to about half the
smallest dimension of your original image (that way, you’ll make most use of the image
resolution available); (3) Clip the image (use just a central circular portion of it) or use all of
it; (4) include the original image or not; (5) mark the location of the mirror with a black dotted
line, or not.

The following example outputs are based on a detail from Leonardo’s Mona Lisa.

            
(whole image, include OFF, mark ON)                           (whole, include ON)
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(clip image, include OFF)                                (clip image, include ON)

Clipped images with the original included—which is what you are going to see if put a mirror
onto the image—can produce some rather good images which are attractive without having to
use a mirror.

How to construct a conical mirror
Materials required: Mirror plastic, ruler, felt-tip marking pen (eg. “Stabilo Write-4-All”),
compasses (with a large enough pen-holder to take the marking pen), double-sided adhesive
tape.

The construction is a little tricky because the relationship between screen size (pixels) and
printed size depends on the particularities of the viewing software and printer being used. I’ve
found that the easiest procedure is to let the viewing software and printer print to the
maximum possible size (or less, if you prefer) and then start by measuring the diameter of the
central circle as printed. It may be easier to measure this if you select the optional “Mark
location of mirror” in the “Anamorphosis—Conical” dialog box:
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If you use the default “cone angle” setting for the anamorphosis (30 degrees), then this
diameter distance (D) becomes the radius for the piece of mirror plastic that we are going to

cut out. (For any cone angle A, the radius is given by 
A

D

sin2
.)

The cone will be formed from a section of a circular disc; using the default cone angle of 30
degrees, this section is a semicircle. (For any angle A, you will need a section whose angular
size in radians is Asin2π ; to convert to degrees, multiply by 180/• .)

               

Mark out this semicircle onto the mirror plastic. Note that on some types of this plastic, one
side is more reflective than the other, so make all marks on the duller side. Also mark out an
additional thin slice (as shown) which will form the “gluing flap” to stick the cone in place.
Cover the area of the flap (shown in red) with double-sided tape, trimming away any excess.

Now fold the disc into a cone shape—take hold of the outer edge and push the centre away
from you. The two edges marked in red (below) must be made to meet, with the flap on the
outside.
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When the edges meet satisfactorily, press down on the flap to glue the cone into place—start
pressing from the bottom of the cone, and take particular care with the join at the top of the
cone (it is not possible to get this exactly right).

Your cone is now complete. It’s a good idea to wipe the outer surface with a tissue since any
oil from your hands will spoil the reflectiveness.

You’ll notice that Mona Lisa’s mouth does not look right. This is because the cone shape is
not perfect at the top and neither will be the reflections from it. Therefore, for conical
anamorphoses you should try to avoid having important parts of the image near the centre.


